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CChhaapptteerr   11::   SSOOFFTTWWAARREE  IINNSSTTAALLLLAATTIIOONN  AANNDD  SSEETTUUPP  

Minimum System Requirements 
• IBM Compatible with Pentium, Celeron or compatible processor. 
• Windows 95, 98, Millennium, NT or 2000 Operating System. 
• A minimum of 16MB RAM. 
• 20 MB of free disk space. 
• Parallel Port and/or Serial Port. 
• SVGA Monitor with minimum resolution of 800 x 600.  
• Microsoft Internet Explorer.  

 

Install CFE Lite 
1. Before installing on Windows NT or Windows 2000, you need to log onto your PC as 

Administrator. 
2. Insert the CD-ROM into the CD Drive.  

2.1. The CD is AutoPlay enabled and should display the AVR splash screen. Click on the CFE Lite 
button and follow instructions. 

2.2. If the AVR splash screen does not appear, select the CD icon and then select File > AutoPlay or 
simply double click on the CD icon.  

2.3. If the AutoPlay does not work on your CD drive, right click on the CD drive icon, select Open, 
and double click on “Setup.exe” to start the installation.  

3. The Install Wizard will guide you through the installation. The program is installed in C:\AVR 
Communications LTD\CFE Lite. A shortcut named CFE Lite will be mounted on the desktop of your 
PC. A folder named CFE Lite will be installed in Start menu\Programs folder.  

4. Start the program by clicking on the CFE Lite shortcut on your desktop. 
5. To uninstall CFE Lite, go to Start/Programs/CFE Lite/Uninstall CFE Lite. 

 

Getting Help 
Information about CFE and ImpaCt is available in a variety of sources: 
• CFE Lite User Guide: is available in printed form or as interactive PDF file, which you can read on 

your PC monitor using Acrobat™ Reader.  To view the guide select Help > OnLine Documents. 
• Tool Tips: to see the name of an object, position the mouse pointer over the button until the name 

appears.  
• On screen Help: to see a description of an object (button) in a window, Right click on the object. To 

see a description of an object (button) in a tool bar or menu, select the object and press Shift+F1.  
• Info Buttons:  provide detailed information on specific CFE functions.  

Things to Remember 
� Muting of ImpaCt Program Switch  - Upon the first communication with CFE, ImpaCt's Program 

Switch is disabled to prevent the client from tampering with the switch during the fitting session. The 
switch will become enabled once ImpaCt is turned OFF and ON again. 

� Reconnect - If you add, replace or remove an instrument, you should use Reconnect to update CFE. 
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CChhaapptteerr   22::   HHAARRDDWWAARREE  IINNSSTTAALLLLAATTIIOONN  

Connecting SFI-09 to any PC and any model of ImpaCt 
1. Locate the Serial port (9-pin D type RS232 connector) on your PC. Unplug any other peripheral if 

connected. Connect the SFI-09 to the serial port. 
Note: For CFE Lite you do not need to connect the Audio cord with stereo plug to your sound card. 

2. Connect the AC/DC adaptor to an electrical outlet and connect the 9V DC plug to the socket on the 
SFI-09. 

3. Connect the RJ-11 phone jack at the end of the BJA-4 (for DSR675), BJA-4/13 (for DSR13), or BJA-6 
(for DSR-ITE), to the telephone socket on the SFI-09. 

4. For a BTE ImpaCt - place a fresh hearing aid battery in the BTE. Connect the BJA-4 or BJA-4/13 
programming boot to the BTE. If you are connecting two ImpaCts, verify that one is set to Left and the 
other to Right.  Otherwise connect only one ImpaCt at a time and follow the Connecting Two BTE 
ImpaCts procedure.  

5. For an ITE ImpaCt - connect the DIN plug of the Right and/or Left Programming Module (PMD) to 
the socket on the BJA-6. Remove the battery door from the ITE and insert the programming module 
into the battery compartment. For detailed instructions, see the supplement titled ImpaCt ITE Battery 
Door Removal.  

Connecting ImpaCt to a HIPRO 
1. Follow manufacturer instructions for connecting HIPRO to your PC. If this is the first time you are 

using the HIPRO, you must first run the program 'Hiprotst.exe' located in C:\AVR Communications 
LTD\CFE Lite. 

2. For a BTE ImpaCt  
2.1. Connect the MiniDin plug of the BJA-8 BJA to HIPRO Adaptor to the Left or Right socket on the 

HIPRO and the RJ-11 socket to the BJA-4 or BJA-4/13.  
2.2. Place a fresh hearing aid battery in the BTE. 
2.3. Connect the programming boot of the BJA-4 or BJA-4/13 to the BTE.  
2.4. If you are connecting two ImpaCts, verify that one is set to Left and the other to Right. Otherwise 

connect only one ImpaCt at a time and follow the Connecting Two BTE ImpaCts procedure.  
3. For an ITE ImpaCt  

3.1. Connect the DIN plug of the Right and/or Left Programming Module (PMD) to the Right and/or 
Left socket on the HIPRO.  

3.2. Remove the battery door from the ITE. For detailed instructions, see the supplement titled 
ImpaCt ITE Battery Door Removal.  

3.3. Insert the programming module into the battery compartment. 

Connecting PFI-25L to a Laptop PC and ImpaCt BTE 
Note: PFI-25L will not work on computers running Windows NT or 2000. 

1. Locate the Parallel (printer) port on your PC. Unplug any printer or other peripheral if connected. 
Connect the PFI-25L to the Parallel port. 
Note: For CFE Lite you do not need to connect the Audio cord with stereo plug to your sound card. 

2. Connect the RJ-11 phone jack at the end of the BJA-4 to the socket on the white telephone adapter of 
PFI-25L. 

3. Place a fresh hearing aid battery in the ImpaCt BTE. Connect the BJA-4 or BJA-4/13 programming 
boot to the BTE. If you are connecting two ImpaCts, verify that one is set to Left and the other to 
Right.  Otherwise connect only one ImpaCt at a time and follow the Connecting Two BTE ImpaCts 
procedure. 

  
Communication Errors will occur if two ImpaCts with the 
same ear designation are simultaneously connected! 

Warning! 
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CChhaapptteerr   33::   SSTTAARRTTIINNGG  CCFFEE  LLIITTEE  

Startup modes 
Follow Software and Hardware Installation procedures. 
With programming interface and ImpaCt(s) connected, 
double click on the CFE Lite shortcut on your desktop. 
The StartUp Status box will appear showing the 
connection status of programming interface and 
instruments.  
1. If the programming interface (i.e., SFI , PFI or 

HIPRO) is not detected, you will see the "Interface 
Not Detected" status. You have the following 
options: 
1.1. Click Ignore, to work in the Virtual Mode.  
1.2. Follow instructions to troubleshoot the 

programming interface and click Retry. 
1.3. Click Plug and Play to detect the programming 

interface on another port. 
1.4. Click Close to exit CFE Lite. 

2. If the programming interface is detected but 
instruments are not found connected, you will see 
the "No Connected Instrument(s)" status. You have 
the following options: 
2.1. Click Ignore, to work in the Virtual Mode.  
2.2. Follow instructions to troubleshoot the 

instrument and connection and click Retry. 
2.3. Click Close to exit CFE Lite. 

3. Click Ignore, to work in the Virtual Mode or follow 
instructions to troubleshoot and connect to 
instrument(s). 

4. If only one instrument and the interface and are detected, an arrow will blink under the connected 
instrument and the ear icon will be colored in the respective Red/Blue color. A Gray ear and an image 
of a broken cable indicates an instrument is not connected.  

5. If the interface and two instruments are detected, click on Red or Blue arrows to open in monaural 
mode or click on the Binaural button to open in binaural mode.  

6. If instruments are assigned to a client (owner), CFE automatically finds and displays that client’s 
name. If instruments belong to different clients, you can select which client to open.  

7.  You may initiate the StartUp procedure at any time by selecting StartUp from the Tools menu or by 
clicking the Reconnect button on the Instrument tool bar. 
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CChhaapptteerr   44::   IINNTTRROODDUUCCTTIIOONN  TTOO  CCFFEE  LLIITTEE  SSCCRREEEENNSS  AANNDD  TTOOOOLLSS  

Screen areas 
Much like the actual fitting process CFE Lite's screen is divided into three main areas: 
• The Client area - located in the top left quarter of the screen. 
• The Instrument area - located in the top right quarter of the screen. 
• The Work area - located in the lower half of the screen. 

SCREEN EXAMPLE NO. 1  
Showing Client Audiogram, Left instrument 
and Formula work area: 
 

 

 

 

 

 

SCREEN EXAMPLE NO. 2  
Showing Client Profile, Left instrument and 
Fitting Tips work area.  
 
 
 

 

 

 

SCREEN EXAMPLE NO. 3  
Showing Client Personal Information, Right 
instrument and Records List work area: 
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Buttons toolbar 
The button toolbar at the top of the screen is also divided into three sections with the following buttons: 
 
 

CLIENT BUTTONS  
Located on the left side of the toolbar 
1. Show All: shows a list of all clients 
2. Search: shows a search tool to find a client by name, etc. 
3. Client Personal Information: shows the clients information such as name, telephone, DOB, etc. 
4. Client Audiogram: shows audiograms 
5. Client Profile: shows the profile for multi-program settings 
6. Client Notes: shows notes with date time stamp 
7. Order Form: launch the Order form utility 

INSTRUMENT BUTTONS  
Located on the right side of the toolbar 
1. In monaural mode: 

1.1. Left Instrument - selects the left instrument 
1.2. Mute Left/Right - mutes the signal from the unselected instrument 
1.3. Right Instrument - selects the right instrument 
1.4. Bin Mode - Bin, selects binaural fitting mode 
1.5. Instrument properties - shows instrument properties 
1.6. Refresh - reconnects instruments, closes Virtual Instruments 
1.7. Save settings - saves a record with the current controls settings 

2. In binaural mode:  
The left instrument shows in the client area on the left and right instrument is shown in the instrument's 
area. 
2.1. Left to Right - copies the settings of the left instrument to the right instrument 
2.2. Right to Left - copies the settings of the right instrument to the left instrument 
2.3. Left Instrument - selects the left instrument 
2.4. Right Instrument - selects the right instrument 
2.5. Bin Mode - Mon, selects Monaural fitting mode 
2.6. Refresh - reconnects instruments, closes Virtual Instruments 
2.7. Save settings - saves a record with the current controls settings 

3. In Virtual Mode:  
3.1. When no instruments are detected during start up, Virtual Left and Virtual 

Right buttons replace the Left and Right Ear buttons.  
3.2. Click on a Virtual Instrument button to work in the Virtual mode. The Program Manager will 

indicate "Virtual Instrument." You can change control's settings, perform 
Formula fitting, set multi-program preferences and save the settings 
into a Saved Settings Record. When you connect a real instrument, you can 
transfer (copy) the settings from the Virtual Instrument's Saved Settings 
Record to the real instrument. 

WORK AREA  
Located on the center of the toolbar 
1. Formula: shows formula fitting and instrument responses in the work area.  
2. Fitting Tips: shows the Fitting tips wizard in the work area. 
3. Record List: shows lists of Assigned and Saved records and tools to manage records 
4. Print: prints reports for clients and instruments. 
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Connecting Two BTE ImpaCts and changing Ear Designation 
1. Before connecting two BTEs, verify that the ImpaCts have different Ear Designations and are correctly 

marked with L/R Ear labels (L = Blue, R = Red).  
2. If you are not sure about the Ear Designation, follow this procedure: 

2.1. Connect only one ImpaCt to the programming cable and launch CFE Lite. 
2.2. Observe the StartUp Status box Note the Ear Designation. 
2.3. Disconnect the ImpaCt and replace with the other instrument. Click Retry on the StartUp Status 

box.  
2.4. Observe the StartUp Status box Note the Ear Designation: 

2.4.1. If ImpaCts have different Ear Designations, connect both instruments, click Retry and OK 
on the StartUp Status box.  

2.4.2. If ImpaCts have the same Ear Designation, do not connect the second ImpaCt. Click OK on 
the StartUp Status box  

2.5. When the main screen opens, click on the Properties button on the right side of the toolbar. 
2.6. From the Properties window, change the Ear Designation and click the Save button. You will 

receive an Instrument Restart message box. For Ear change to take effect, ImpaCt must be turned 
OFF and ON. 

Program Manager 
The Program Manager provides visual representation of the instrument. It displays ImpaCt's memory 
programs and the Instrument ID. 

INSTRUMENT ID  
The right side of the Program Manager shows the following information: 

• Model: ImpaCt Model, example DSR675.  
• Serial Number: ImpaCt Serial Number, example 000575 
• Ear:  ImpaCt Designated Ear, example Left. 

PROGRAM COLUMNS  
The Program Manager shows instrument control’s settings in columns: 

• Memory programs: Keep the control's determined by the clinician in permanent storage. 
• Active Program: The Active Program is what the patient hears. When ImpaCt is turned on, memory 

Program #1 is always loaded into the Active Program.  When the instrument is turned off, the Active 
Program is erased. During normal operation, the user activates the program switch to load settings 
from a memory program to the Active Program and the Active Program is always identical to one of 
the memory programs. During fitting, when you save or load one of the memory programs, the Active 
Program will show the respective program number (e.g. Active [1]) and will become identical to the 
memory program. If during fitting you modify the Active Program, the Active Program will read 
“Active [#] (Not Saved)” reminding you that if you wish to keep the new settings, you need to save it 
to a memory program. 

WORKING IN PROGRAM MANAGER  
1. You can click on each value in Active column to open a combo-box and modify the control’s setting: 

1.1. SOURCE: Indicates the input source assigned to each program: Microphone, Telecoil, FM, 
Microphone + FM and Aux.   

1.2. AGC-I KP: The value of the AGC-I (Input Automatic Gain Control) compression threshold 
(Knee Point), in dBSPL, applied to the microphone or telecoil.  

1.3. AGC-I RT: The nominal value of the Input Automatic Gain Control Release Time, in seconds.   
1.4. AGC-O: The value of the Output Automatic Gain Control attenuation, in -dB.   
1.5. +6DB: En. (enable) adds 6 dB of gain to the output amplifier past the AGC-O to provide the 

listening sensation of a linear instrument. This control is not accessible when the Source is 
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microphone and the AGC-I KP is less than 60dBSPL. If telecoil is selected for the input source, + 
6dB is available for AGC-I KP of 54 and 57dBSPL.  

1.6. HPF: Indicates ten fixed positions of a complex digitally controlled high pass filter. Increased 
values represent increase in "low cut" and shifting to higher cutoff frequencies.   

1.7. LPF: Indicates ten fixed positions of a complex digitally controlled low pass filter. Increased 
values represent an increase in "high cut" and shifting to lower cutoff frequencies.   

1.8. FCVL: Controls proportional Frequency Compression of Voiceless sounds. The FCVL 
coefficient represents the ratio between the original frequency of the input signal and the 
frequency compressed signal at the output of the processor.  

1.9. DCB1: Controls the Dynamic Consonant Boost for high frequency voiceless sounds (e.g., 
typically /s/, /sh/). The value of DCB1 represents additional gain, in dB, to high frequency 
voiceless sounds.   

1.10. DCB2: Controls the Dynamic Consonant Boost for lower frequency voiceless sounds (e.g., 
typically /t/, /k/). The value of DCB2 represents additional gain, in dB, to lower frequency 
voiceless sounds.   

1.11. FCV: Controls proportional Frequency Compression of Voiced sounds. The FCV coefficient 
represents the ratio between the original frequency of the input signal and the frequency 
compressed signal at the output of the processor.  

2. Load Program: Click on buttons above the memory columns (P1, P2 etc.) to load a Memory Program 
from into the Active Program. This will have the same effect as pushing the program switch on 
ImpaCt. 

3. Save to Memory Program: Click on buttons below the memory columns (P1, P2 etc.) to save the 
Active Program to a Memory Program. 

4. 1234 button: When Clicking the "1234" button, CFE automatically saves the Active program to the 
program defined by the Multi Program Preferences in the Client's Profile as Basic/Formula. All other 
programs will be set based on the preferences selected. 

5. ANSI Button: Click on this button to automatically reset all the controls in the Active Program to the 
"Neutral Settings." This is specifically intended for acoustic testing of ImpaCt to conform to ANSI (or 
other) specifications. Standard tests such as ANSI and IEC do not include provisions to test Dynamic 
Speech Re-Coding (Frequency Compression, Dynamic Consonant Boost and Prolongation) features. 

6. REVERT Button: The Revert button appears only after you load settings from a memory program into 
the Active program.  This button is useful if you wish to compare the listening experience of an 
unsaved Active Program and a saved program. 

 

Save 

Load 

Modify 
from 

Active 

Revert 
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CChhaapptteerr   55::   IINNIITTIIAALL  FFIITTTTIINNGG  

Opening a New Client 
3. Click the New Client button. The Client Personal Information area will open.  
4. Enter personal information for the client. 

Entering an Audiogram 
5. Click the Client Audiograms button. The Unaided audiogram area will open. The teal shaded area 

represents the general fitting range of ImpaCt. To select an audiogram type, click on the button with 
the desired symbol. The numeric HL values for the selected audiogram type are shown below the 
audiogram. 

6. Enter the thresholds for the unaided audiogram(s): 
Select (highlight) a frequency box and type the desired HL value. Press the Tab key to move to the 
next frequency. Press Shift+Tab to go back. Do not forget to press Tab after entering the threshold at 
8000 Hz.  

7. The unaided air conduction audiogram values are used for calculation of Formulas. You must enter all 
octave values. Skipped interoctave values will be interpolated and will be shown as DNT (Did-Not-
Test).  

8. To enter a No Response value, type NR, then press Tab and enter the HL value used to test NR. 
9. To hide or show a curve, click in the check box next to the Audiogram button.  

Determining the Number of Programs 
ImpaCt can operate in a two, three or four program mode. For young children or people with dexterity 
problems, the two-program mode is recommended.  
The program switch on ImpaCt functions differently in the two, three or four program mode. Beeps 
that correspond to the program number can be heard.  

1. Review the User's Operating Guide of the model you are fitting to determine the number of programs 
required by the client. 

2. Click on the Properties button on the right side of the toolbar.  
3. From the Properties window, change the Programs Switch.  
4. Elderly people or people with certain types of hearing loss may also need a slower beep speed. Select 

the desired Beep Speed. 
5. Click the Save button. 

Formula Fitting  
1. Click the Formula button at the center of the toolbar. The formula work area will open. The default 

formula options are: 
1.1.  Less AGCI -This will select a higher compression knee-point providing a listening sensation 

closer to that of linear amplification. Selection criteria are: 
1.1.1. Select Less AGCI if your client's previous hearing aid was linear.  
1.1.2. Select More AGCI if your client is unable to use the volume control. 

1.2. Auto is the default formula for calculating insertion gain. Selection criteria are: 
1.2.1. Auto - This formula has been developed especially for AVR's DSR hearing aids. 
1.2.2. NAL-RP - is a standard formula for calculating insertion gain. It is designed for linear 

instruments and will typically prescribe less gain in lower frequencies.  
1.2.3. Other IG or Other 2CC- if you have values from other formulas you would like to use with 

CFE Lite. 
1.3. With DSR/No DSR - The system determines if DSR controls are added to the calculation. 

Selection criteria are: 
1.3.1. Select With DSR if your client cannot discriminate /s/ and /sh/. 
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1.3.2. Select No DSR if your client can discriminate /s/ and /sh/ or is complaining that sound 
quality of DSR controls is uncomfortable. 

2. Click the Fit button to synchronize the calculated control’s settings with the Active program.  
3. Manually adjust the volume control on ImpaCt to the position shown in the Formula window. Also 

adjust the Manual V/C Settings on the Program Manager. 
4. Once you have completed the initial fitting, further adjustments can be made from the Active column 

of the Program Manager.  
5. You will be able to compare the Target, Active (current settings in ImpaCt) and Calculated response 

curves from the "Show" combo-box.  
6. Click the “1234” button on the toolbar located under the Program Manager. The Multi-Program 

Preferences box will open. Define the patient's Profile for multi-program listening preferences.  
6.1. Check the program you would like to set, select a Program Type and click Set. When Program 

Types are selected for all programs, click OK.  
6.2. CFE will automatically save the Active program (your initial fitting) to the program defined as 

Basic/Formula. All the other programs will be automatically set based on the preferences 
selected.  

6.3. This window is shown only once. The multi-program preferences are saved in the Client's record. 
In the future, you may change preferences from the Client's Profile. 

7. Verify the success of the fitting using functional gain testing, speech tests and client’s subjective 
responses.   

8. Use Fitting Tips to improve the fitting based on the client’s comments. 
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CChhaapptteerr   66::     WWOORRKKIINNGG  WWIITTHH  FFIITTTTIINNGG  TTIIPPSS    
Start by loading a specific memory program and with a patient’s comment to his/her listening sensation 
regarding this program.  
1. Search the directory and find the category and comment most similar to the patient’s comment. The 

hierarchy of the directory is structured based on categories, subcategories and finally the actual 
comment you may hear from your patient. The main categories are: 

� Conventional Controls 
• Too loud 
• Too soft 
• Can’t hear 
• Noise 
• Feedback 
• Sound quality 
• Discrimination 
• Male/Female voices 

 
� DSR Controls  

• Too loud 
• Too soft 
• Can’t hear 
• Feedback 
• Sound quality 
• Noise 
• Discrimination 
• Male/Female voices 

 
2. If necessary, use directory subcategories and comments to ask your patient questions that will make 

their comments more specific.  
3. Select (click) a specific comment. The fitting tip controls will open. 

 
4. You will see the controls that typically affect the selected comment. The controls are displayed in 

order of typical significance (steps).  Next to each control you will see a bar with a black circle 
marking the Starting Point. 

5. Click Better to modify the control by one step. A "√" will appear on the control’s bar marking the new 
setting relative to the Starting Point. Initially the direction of change will be the common modification 
required for the patient's comment. 

Controls 

Better 

Worse 

Next 

Previous 

End 

Starting 
Point 

Reset 
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5.1. If the patient indicates the sensation is “better,” click Better. 
5.2. If the patient indicates the sensation is “worse,” click Worse. This will modify the control one 

step backwards. An "X" will appear on the control’s bar marking the new position and reverse the 
direction the next time you click Better. 

Note: If the control is Volume Control (V/C), you need to manually adjust it to the best position and 
then click the Next step button. 
5.3. If the patient indicates "no change" (that means that any click on Better results in a worse 

response), click Next Step. If you have reached the maximum or minimum value of the control, 
CFE Lite will automatically jump to the next step (control). 

6. To go back a step, click Previous step.  
7. If the client is confused or the client’s responses are contradicting, you may click the Reset button next 

to the control where your client was responding consistently and retest. 
8. End Tip Button: When in a fitting tip session, many functions of CFE Lite are frozen.  To end a Fitting 

Tip session and continue working, you must click End Tip. 
 

CChhaapptteerr   77::   WWOORRKKIINNGG  WWIITTHH  RREECCOORRDDSS  LLIISSTT    
Records list is designed to organize and keep a history on the data in a particular instrument.  The 
descriptions and commands below can be used to locate client information, view current settings in an 
instrument, transfer settings from one instrument to another, and insert notes. 

ASSIGNED INSTRUMENTS RECORDS  
CFE Lite will automatically ask you if you want to assign a new instrument to a client. If the instrument is 
permanently dispensed on a client, click Yes. An instrument can be assigned only to one client. The record 
for an assigned instrument is constantly updated with every change you make to the instrument's settings. 
Records for instruments assigned to a client are shown in the window, including Serial number, Designated 
Ear, Model and last fitting date/time. When you select a record from the list, detailed information and the 
settings are located on the right side of the work area. 
 
� Useful Tip: Access current settings in the instruments whether the instrument is in the office or not. 
 
� Because CFE constantly updates your modifications- you don’t have to worry about saving changes to 

the settings.  
� The serial numbers of assigned instruments are used by the CFE to automatically find and open the 

client who has been assigned the instruments. 
� When a fitting has been modified on another PC (or on the CFP-2008 "hand-held" programmer), or an 

instrument was sent for repair and not reprogrammed, CFE Lite automatically detects unmatched 
controls between the instrument and its assigned record.  

SAVED SETTINGS RECORDS  
When you click on the Save Settings button on the main tool bar, CFE Lite saves a record with the current 
controls settings. Save Settings Records are shown in the window, including Serial number, Designated 
Ear, Model, last fitting date/time and Notes. When you select a record from the list, detailed information 
and the settings are located on the right side of the work area. 
 
� Useful Tip: Settings for a Virtual Instrument can be saved and later transferred into the real instrument 

before or during the client’s appointment (see Transfer Record to Instrument function). 
 
� A Saved Settings Record is not modifiable. Use Save Settings Records to backup controls settings so 

that you can always return to the settings you had prior to making modifications to programs.  
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ASSIGN INSTRUMENT 
Usually, CFE Lite will automatically ask you if you want to assign a new instrument to a client. Otherwise, 
click on this button to assign an instrument to a client and open a record for the instrument in the Assigned 
Instruments Records window. 
 
Remember: An instrument can be assigned to only one client. 

COMPARE RECORDS  
Compares settings between any two selected records: 
• Select one record from Assigned Instruments and one record from Saved Settings.  
• Select two records from the same list. Select the first record, then hold down the Ctrl key and select a 

second record.   
 
� If more than two records are selected, only the first two selections will be compared. 

UNASSIGN RECORD/DELETE RECORD  
If an Assigned Instrument Record is selected, this button is named Unassign. Click on this button to 
Unassign the instrument. This will release the instrument and enable you to assign it to another client.  
A Saved Settings record of the unassigned instrument will be saved automatically. 
If a Saved Settings Record is selected, this button is named Delete Record. Click on this button to delete 
unnecessary Saved Settings Records.  

INSERT/EDIT NOTES  
Inserts or edits a note to a Saved Settings Record.  
 
Useful Tip: Enter information that will assist you in finding this record in the future. 

OPEN AS VIRTUAL  
Open a record as a Virtual instrument. 
 
� Useful Tip: Use this function to work with a record in Formula or Fitting Tips work area. 

TRANSFER RECORD TO INSTRUMENT 
Updates the settings in the Instrument's memory with the settings of the selected record. Use to restore 
settings to an instrument. 
 
� Useful Tip: When you connect a real instrument, you can use this function to transfer the settings from 

a record to the real instrument. 



CFE Lite Quick Reference Guide 

 
Rev. 1.1. 2/20/2001  Page 16  
 

CChhaapptteerr   88::   DDAATTAABBAASSEE  MMAANNAAGGEEMMEENNTT  

Setting up CFE Database 

INTERNAL DATABASE 
This is the default database mode. The database file is named CFE Lite.mdb and it contains Clients and 
Instruments data. If you have followed CFE Lite’s default installation procedure, this file is located on 
your hard drive at the path: C:\AVR Communications LTD\CFE Lite\doc. 

EXTERNAL DATABASE  
This database mode allows you to work with CFE Lite database files located in other folders or drives 
on your PC, and database files located on other PCs via local area network. There are certain 
advantages to sharing your CFE Lite database over the office network: 

• CFE Lite's unique ability to trace clients by ImpaCt's serial number and verify control’s settings 
integrity are not limited to the computer on which the client was first fit.  

• You can fit a client on one PC and then move to another PC (for example in the sound booth) to test or 
continue working.  

• The data of all ImpaCt clients in your office will be accessible to all the PCs on the network. 

COMPRESS DATABASE 
As you change data in the database, the database file can become fragmented and use more disk space 
than necessary. Periodically, you should compress your database to defragment a database file. The 
compacted database is usually smaller and easier to backup. 

 

Importing CFE Database  
If you would like to import the data from CFE Ver.1.3, CFE Ver.2.0 or CFE Lite to your CFE Lite Internal 
database, follow the steps below: 
1. Start CFE Lite in Virtual Mode (see Chapter 3: Starting CFE Lite). 
2. From Tools menu select Database Management > Import Database. The Import Database dialog box 

will open. 
3. Locate the CFE.mdb file that you would like to import: 

3.1. In CFE Ver.1.3 this file is typically located in the path: C:\Program Files\AVR Communications 
LTD\Clinician Fitting Environment\doc.  

3.2. In CFE Ver.2.0 this file is typically located in the path: C:\Program Files\AVR Communications 
LTD\CFE 2.0\doc.  

4. Click Open. The imported data will appear in the Client Console. 
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Working with External Database 

Setting up an External Database on your PC 
1. Create a new folder on your hard drive and name it “External CFE Lite database” (example: C:\ 

External CFE Lite database).  
2. Go to C:\AVR Communications LTD\CFE Lite\doc. Locate the file CFE.mdb and copy the file to the 

new folder at: C:\ External CFE Lite database.  
3. Start CFE. Select Tools > Database Management > External Database. A dialog box “Select External 

Database” will open. Locate the file CFE Lite.mdb using the path created in item 1 above (example: 
C:\ External CFE Lite database). Click Open 

4. When you start CFE again it will automatically look for the External data base.  

Setting Up an External (Shared) Database on another PC  
Before you can set a CFE shared database, you need at least two PCs connected via Local Area Network 
(LAN) or a network server using standard communications protocols such as TCP/IP, IPX/SPX or 
NetBEUI.  

Note: To set up a computer to use a network, you need both hardware and software. To set up your 
network hardware, follow the directions included with your network card or adapter, and then look 
up, “Setting up, hardware” in the Help Index. To set up the network software to work with 
Windows, look up “Setting up, network software,” “Setting up, network services,” “Connecting to 
the network” and “Sharing files and printers on a network.” 

Once you have your network set up, follow these steps to share a CFE Lite database: 
1. Select the Host PC that will share the database with others. This is typically a PC that will be on during 

the entire workday. If you have a Server, select it to share the database.  
2. Create a new folder on the Host PC’s hard drive and name it CFE Lite Sharing (example: C:\ CFE Lite 

Sharing). 
3. Right click on the folder’s icon and select Sharing to see Shared Properties. Select Access type: Full. 

Leave Full Access Password empty. Click OK. 
4. Install CFE on the Host PC. Follow the default installation procedure. 
5. Go to C:\AVR Communications LTD\CFE Lite\doc. Locate the file CFE Lite.mdb and copy the file to 

the shared folder at C:\ CFE Lite Sharing.  
6. If you do not wish to install CFE on the Host PC or already have an active CFE database on your PC 

and would like to share it with others, skip steps 4 and 5. Simply copy the file CFE Lite.mdb from 
another PC to the shared folder at C:\ CFE Lite Sharing on the Host PC. 

7. Start CFE on another PC connected to the Host PC via the network. Select Tools/Database 
Management/External Database. A dialog box “Select External Database” will open. From the Look In 
Combo-box select Network Neighborhood and locate the file CFE Lite.mdb using the path: Host 
PC\\C:\ CFE Sharing. Click Open. 

8. When you start CFE again it will automatically look for the shared database on the host PC.  

Note: If the Host PC is not available on the network or CFE Lite cannot find External database during 
CFE Lite startup, CFE Lite will automatically switch to work in Internal database mode. 
You may rename the database file, but you must maintain the extension *.mdb, example:  
“My CFE Lite.mdb.” 
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AAppppeennddiixx  AA::   CCFFEE  LLIITTEE  TTRROOUUBBLLEESSHHOOOOTTIINNGG  

Contact AVR 
For troubleshooting beyond the scope of this list, refer to the CFE User Guide or contact AVR for 
assistance:  
Toll Free:  800/462-8336  
Telephone:  952/934-3111  
Fax:   952/934-3033  
Email:   sono@avrsono.com  
 
Remember: Before contacting AVR, please prepare a step-by-step description of the problem as well as 
the entire text from any error messages you receive. 

Communication Error Check List 
In case of Communication Error message first check the following: 
1. Click Retry. 
2. Check if ImpaCt is ON (listen to feedback sound). Does ImpaCt have a fresh Zinc Air battery? 
3. Check programming cable is firmly connected to ImpaCt and BJA is plugged into the fitting interface 

and interface firmly connected to PC.  
4. If fitting binaurally: 

4.1. Connect only one ImpaCt at a time and check Communication. 
4.2. Verify that ImpaCts have different Ear Designation and are correctly labeled with L/R Ear labels  

(L = Blue, R = Red). Otherwise, see Connecting Two BTE ImpaCts and changing Ear Designation 
for instructions on changing Ear Designation. 

5. Select Communications from the Tools pull-down menu and check proper port selection. 
6. Follow instructions on error message. 

Display Problems 
If CFE window is not properly displayed on your PC’s monitor:  
1. Right click on the desktop background, select Properties and click on the Settings tab.  
2. Set the Desktop area to 800 by 600 pixels.  
3. Set the Font size to Small Fonts.  
4. You may experience display problems when using the program on Japanese, Korean and Chinese 

operating systems. 
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